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Introduction

Frequency Intermodulation

  Frequency Intermodulation (IM) occurs when 2 or more frequencies create new and usually unwanted frequencies that

can cause interference. The general equation describing intermodulation frequencies is:

 

where

  IM is the newly created intermodulation frequency,

  n
1,2,3..

 are integer (+ or -) transmitter coefficients

  A, B, C are the existing radio transmit frequencies

If IM falls within the bandwidth of a receiver, it may cause interference in that channel.

The intermod order is the sum of the absolute values of all the transmitter coefficients:

For example, A + 2B - 2C will give an intermod order of 5 (|1| + |2| + |-2| = 5).

F-Intermod calculates intermodulation products in a given bandwidth, equal to or below a selected intermodulation order.

Intermod Frequency Power

Power of each intermod frequency is calculated using the below equations.
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The following assumptions are used for all F-Intermod calculations:

a. All intermod frequencies are created at one location.

b. Transmitter carrier frequencies are not modulated and have no bandwidth. 
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c. Nonlinear coefficient for each intermod order are determined by field measurements. Required only if absolute

intermod power level is required, see below explanation on Intermod Power.

d. Losses due to propagation and/or transmission are not considered in Intermod frequency power calculations

See below section Calibrating Intermod Power for more details. 

Note, accurate values of nonlinear coefficient need to be used in order to achieve accurate intermod power levels.  Do not

use default nonlinear coefficients provided with this program to determine absolute intermod levels.

Why do I need to calculate intermodulation products?

  Intermodulation products should be calculated before installing two or more radio transmitters at a site in order to

determine what new frequencies may be created by intermodulation. These new frequencies can cause serious

interference with the site radio receivers and other nearby receivers. It is also a requirement by many frequency spectrum

regulating agencies to ensure interference is not created for other existing radio stations.

Optical Four Wave Mixing

  This program also calculates fiber optic system four wave mixing (FWM) products that can occur in DWDM links.  Four

wave mixing is the fiber optic equivalent to radio frequency intermodulation interference and can cause interference over

DWDM channels.  This software calculates the possible interference frequencies that may occur in DWDM system. 

Enter the DWDM channels in THz.

Additional Intermod information can be found at these sites:

Wikipedia - Intermodulation

www.tpg.com - Good explanation

ARRL explanation

Installation

  Download the FIntermodSetup.exe file onto a temporary directory in your computer then run FIntermodSetup.exe. You

may also run it directly from a CD. Follow on screen instructions as the program loads. FIntermodSetup.exe can be

deleted after installation is complete.

  This restricted version of F-Intermod will only calculate the Intermod frequencies for up to 3 channels, and will expire

after 20 days. After the trial period expires, you will be prompted to purchase a license key. If you have purchased a

license, enter the unlock code when prompted. The registered version will calculate intermods for up to 10000 channels.

 

Program Operation
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INPUT

  First, choose a frequency unit for F-Intermod to use. The default unit is MHz.  To change it to another unit such as kHz

or GHz, click Options -> Base Frequency Unit and select the desired unit. This must be done when the input table is

empty. 

Channel Name

Enter the channel name or label to a maximum of 12 characters. An entry in this field is not required.

Tx Frequency

  Enter a transmit frequency for the channel. The maximum and minimum value that can be entered are 999,999.99999

and 0.00001 respectively.  Note that this software assumes that the Tx frequency is not modulated and has no bandwidth. 

If Tx bandwidth results are required, user may want to run F-Intermod multiple times and change the Tx frequency to the

end points of the Tx bandwidth in order to capture intermod frequencies that may be produced across the Tx bandwidth.

Rx Frequency

  Enter a receive frequency for the channel. The maximum and minimum value that can be entered is 999,999.99999 and
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0.00001 respectively.

Half Bandwidth

  Enter the receiver half bandwidth for the communications channel. For example, if the bandwidth is 30 MHz then enter

15 MHz.  Maximum value is 500,000.00000 and minimum value is 0.00000.  If zero bandwidth is entered, only intermod

frequencies that fall exactly on the Rx frequency will be displayed.  All output and display bandwidths are half bandwidth

values.

Duplex, Half Duplex or Simplex

  Select whether this channel is Full Duplex, Half Duplex or Simplex.  Note that if Simplex is chosen you must enter a

transmit OR receive frequency, not both.

For duplex setting, the program assumes that the channel transmitter and receiver are on all the time.

For half duplex setting, the program assumes that the channel transmitter or receiver are on, but not at the

same time.  So when the transmitter is on the receiver is off and vice versa.  Therefore intermod created by

the channel's transmit frequency will never appear in that channel's receiver.

For simplex setting, the program assumes that there is only one way communications.  That is for that

channel only the transmitter is on always (100%) or the receiver is on always (100%).  But not both at any

time.

Power

  Enter the transmitter effective radiated power (ERP) power in Watts

Run

  Click to run the calculations for the input data seen in the input table.

Clear All

  Clears and resets all the data input and output tables, except for units.

Clear Out

  Clears only the output table.

Add

  Click "Add" to enter data (Channel Tx Frequency, Rx Frequency, Half Bandwidth) into the input table.

Delete Row

To delete a channel, click on the row in the input table to select it and then click "Delete".

List Intermod Frequencies

  If "For all channels" is selected, the program calculates all intermod frequencies normally.

  If "For planned channels" is selected, the program will only display the intermod frequencies that the planned channels

contribute to. This is useful for calculating the intermod frequencies for new transmitters/receivers being added to an

existing site.  A channel can be designated as planned by double clicking on the channel's "Status" entry in the input

table.  A planned channel row will be green.

  If "For existing channels" is selected, the program will only use the existing channels in the calculation. Planned

channels will not be included and will not be displayed in the output results.

  Channels are labeled "Existing" by default. To change the status to "Planned", double click on that cell in the input table.

Planned channels are highlighted in green
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Intermod Order

  Enter the intermod order, an integer from 3 to 31 inclusive. Typically intermod orders of less than 7 are used.  For odd

intermod order use the pull down selection. For even intermod order, type value into the selection box.

Single Intermod Order

  Select this check box if you want the output to display only intermod order products of order equal to the order selected

in the "Intermod Order" box.  If it is not checked, the output will display intermod products up to and including the order

entered in the "Intermod Order" box.

Include Tx Frequencies

  Select this check box only if you want intermod frequencies to be calculated that fall in the transmitter’s frequencies

bandwidth (transmitter intermod) and receiver frequencies bandwidth.  The program assumes the transmitter bandwidth is

the same as the receiver bandwidth.  If the is not selected only intermod frequencies that fall in the receiver bandwidths

will be calculated.  For an intermod study that is only concerned about receiver intermod interference leave this box

uncheck.

Display Channel Name in Results

  Select this check box if you want to see the channel name in the output table rather than its frequency. Channel name

size is maximum 12 characters.

List All Intermod

  Leave this box normally unchecked unless you want to display all intermod frequencies created from 0 Hz to 1000

GHz.  If this box is checked, output intermod listings can still be filtered into a more narrow frequency range by selecting

"Specify Output Frequency Range".

Specify Output Frequency Range

  Leave this box normally unchecked unless you want to specify an output frequency range, then enter the lower and

upper frequency range limits into the two boxes.

Input Table Copy, Paste, Delete Editing

  Right click while the mouse is over a input table cell will produce an additional menu that will allow you to Copy, Paste,

Select Column, Select All and Delete.  You can copy one or more entries to and from Excel using this method.

To copy columns of data from an Excel spread sheet, highlight the column of frequencies to be copied in Excel and select

copy.  Then in F-Intermod input table click on the first frequency cell that has been copied, right click and select paste.

Individual input table cells can be edited directly by double left clicking on the cell.

Any input or output table column can be sorted, ascending or descending, by double right clicking on the header of the

column to be sorted. 

Channel Database  (click on  <<  button)
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Click on the << button to access the Channel Data form. This is another method to view, edit and add information to the

Channel Database.

To edit a channel, make changes on the form and then click "Save Data".  To add a new channel, click "Add New

Channel", enter the information then click "Save Data".

 It is possible to export the Channel Database (Input Table) to an MS Excel compatible CSV file or to a text file as

records. Click on File, then Export Channel Database. The text file will display each channel data as separate records.

 When all your channels have been correctly entered, press RUN to execute the program. Depending on factors such as

the number of channels, intermod order, bandwidth, and speed of your computer, the run process can take a second or

hours.  You may stop the calculations by pressing "CANCEL" at any time.

Output

 The output is displayed in chart form sorted by intermodulation order (Order) and intermodulation frequency (I.Mod

Freq.).  Sorting by other columns is possible by double clicking on the header of the column to be sorted.  Note sorting

the I.Mod Freq, Power,  Channel and  Difference columns will take much longer than other columns since a special

sorting routine is used for these columns.
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If no intermodulation (IM) listings are found, then a red “No IM Found” label will be displayed in the “Total Listings

Found” (called Intermod Total in new versions) box.

Columns

  The first column "Order" contains the intermodulation order of calculated intermodulation frequencies.

  The second column "I.Mod.Freq." contains the calculated intermodulation frequencies in units selected.

  The third column "Channel R/T" contains the channel frequency (or name if "Display Channel Name" selected) that is

being interfered. The "R" or "T" designates if the intermod is receiver or transmitter intermod.

  The fourth column contains the difference between the calculated Intermod frequency "I.Mod.Freq." and the channel

frequency being interfered.  Note, if "List All Intermod" option is selected, then values in this column have no meaning.

  The remaining columns, identifying header is Tx frequency, channel name, or C0xx (in printout), contain transmit

frequency coefficients (n
1
, n

2
, n

3
...) that produced the listed intermodulation frequency "I.Mod.Freq.". 

  Note that the speed of the program depends on the number of Tx and Rx frequencies, intermod level, and bandwidth

entered. To speed up the calculations, use a lower intermod level, do not select Include Tx Freq option, or use a faster

computer. Also select Single IM Order to reduce output.

Printing and Exporting Output

 To print the output, click File -> Print or press Ctrl P. To view the print preview, click File -> Print Preview.

Note: If there are more than ~ 9 transmit frequencies, not all of the transmit frequency output columns will show in the

printout due to paper width limitation. Transmit columns after the 9th frequency will be truncated.  To print more

columns, try changing paper orientation to "Landscape".  This does not effect the number of Intermod Frequency rows

(intermod products) that are printed. 

Note, printer font size is set to Courier 8. Increasing font size will result in misaligned rows in printout and unreadable

The output can also be to exported to a text file, MS Excel compatible CSV file, or text file which displays the intermod

equations rather than the output grid. For example, if the intermod frequency is 138.365 MHz, the file will display the

equation for this frequency as

138.36500=(-1)(154.01000)+(1)(149.71000)+(1)(142.66500)

where (-1), (1) and (1), are the intermod coefficients, and 154.01, 149.71 and 142.665 are sample transmit frequencies.
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 The CSV file can be opened with any spreadsheet program. It will show both the input and output tables along with the

channel database data.

Output Too Large for Grid

  If there is a large amount of data to display, the display table may have insufficient size to show all results. Before the

limit is reached, F-Intermod will prompt the user to save the calculated intemod listings to a file. The data is then saved to

one of 3 file formats (.txt, .csv and .txt displaying intermod equations) that is selectable by the user in the File/Save output

to Overflow file... menu.

Note: Some programs will be incapable of displaying large files.

The text files can be viewed with Microsoft WordPad or any standard text word processor.

For very large text files that WordPad cannot open, use other programs available from the Internet that can open large

files such as Textpad available at www.textpad.com.

Copying

Right click while the mouse is over the output table will produce an additional menu that will allow you to Copy, Paste,

Select Column, and Select All.  You can copy one or more entries to the clipboard.  However you cannot  paste to the

output table.

TP ( Total Power)

This button is only available if the Power feature is purchased.  It sums all intermod powers that fall onto the same

frequency or same channel.  If "List All Intermod" is selected, the result is the sum of all intermod powers that fall onto

the same frequency.  If "List All Intermod" is not selected the result is the sum of all intermod powers that fall onto the

same channel.  Note, that this button is only shown if you have the Power Option license installed and after you get results

by pressing the Run button.

If the number of intermod listings overflows into an overflow file, then this feature will not be able to sum any of the

overflow intermods.  It only sums intermods shown in Output Table.

Menu Options
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File

New Channel Database - Clears the input and output tables.

Load Channel Database - Opens a saved input file with ".cdb" extension. Note, it will also load older version ".txt"

database files.  Use this option if you have an input file saved from a previous version of F-Intermod, starting from R3.3.

Load Channel Database from R3.2, 3.1 or 3.0 - Opens a saved input file from R3.0 to R3.2. You must use this option if

you have an input file from these versions. Using the previous Open Program File option will not work.

Save Channel Database - Saves the input table data and options to the current selected file name with extension ".cdb" 

(for future loading with "Load Channel Database"). Note this is a change from earlier versions that saved the database as

".txt" file.

Save Channel Database as... - Saves the input table data and options to a  file name with extension ".cdb" for future

loading with "Load Channel Database".  It is saved with the a new filename selected by the user.

 

Load Template - Opens a saved template, just F-Intermod configuration settings does not affect loaded channel data. Has

".tpl" extension.

 

Save Template - Saves template file for future use with ".tpl" extension. This template file stores all F-Intermod

configuration options that are currently set.  Does not save channel data info.

Print preview - Display how the output will be printed.

Print... (Ctrl+P) - Print the current input and output.

Export channel database...

MSExcel - Exports the input table data to an MS Excel compatible CSV file.

Text file - Exports the input table to a text file displaying records rather than a table.
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Export Intermod output ...

Text file - Exports the output table to a text file.

MS Excel compatible CSV file - Exports the output table to a CSV file which can be opened with any spreadsheet

program, including MS Excel.

Text file showing intermod equations - Exports the output to a text file showing the Intermod Equations rather than a table.

Save overflow output to file...   Select one file format that will be used by the program to save the output when screen

output table is too small to display all intermod listings.

Exit - Ends the program.

Options

View Channel Info... - Displays the extra channel information dialog box.

Units - Set the frequency unit to kHz, MHz, GHz, THz or nm. The default unit is MHz. This option can only be set when

the input table is empty.

Auto Rx Freq - If checked, then receive frequency will be automatically calculated from the difference between the last

transmit and receive frequency pair.  Default difference (on startup) is zero.

 

Nonlinear Coefficients - Enter proper nonlinear coefficients for each intermod order to obtain accurate power output

levels for that order.

Industry

Selecting the appropriate industry will hide non appropriate options for that industry.  Selecting "Radio" industry will

show all options.

Help

Guide - Opens this document in your default internet browser.

About - Displays program version and a link to our website, www.telecomengineering.com.

Check for Updates... - Checks for a newer version of F-Intermod at www.telecomengineering.com. If a newer version

exists, you will be prompted to download the new installation file. Note: If you have any type of software firewall

running on your computer, be sure to allow F-Intermod to access the internet for this option to work.

 

Calibrating Intermod Power

 

In order to achieve any accuracy in the calculated intermod output powers, each intermod order's nonlinear coefficient

needs to be calibrated and adjusted to your project's specific environment. 

 

Note, the default nonlinear coefficients loaded when the program starts will not provide any degree of accuracy of

intermod power outputs and should not be used as absolute values.  However the default non linear coefficients can be

used to generate intermod frequency powers that can be viewed as relative values.  These relative values will provide

worst and least offending intermod frequencies within each intermod order.

 

To calibrate and determine the nonlinear coefficients, follow the below procedure.

 

If the nonlinear coefficient for each intermod order is known for the environment then select menu Option and click

Nonlinear Coefficients.  Enter the nonlinear coefficient directly for each intermod order.  When a nonlinear coefficient

value is entered it is immediately stored, do not click Calculate.
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If the nonlinear coefficient is not know then:

a. Find one of the fundamental carrier frequencies that is generating the intermod products and measure its

power and the power of all of its harmonics to the highest order needed in your calculations.  For best

accuracy use an unmodulated carrier.  For example if you need to determine intermod products up to and

including 5th order, then measure all harmonics of a carrier up to and including the 5th harmonic.  For best

accuracy be sure that there are no other interfering carriers at the same frequency as the carrier fundamental

or the harmonics which will skew measured results.

b. Click the menu Options and then Nonlinear Coefficients and enter for each intermod order the carrier

power and each harmonic power.  Click Calculate for each intermod order for the nonlinear coefficient to be

calculated.

If a carrier frequency harmonic cannot be found or is not available, it is possible to calibrate using intermod frequencies

as follows:

a. Find an intermod frequency for each intermod order that can be measured.  It is important to ensure that

there is only one intermod existing on the frequency (also no other interference at this frequency).  To do this

run F-Intermod and sort by Intermod frequency to determine if more than intermod could occur on the

frequency.

 

b. Measure the power of each intermod frequency for each intermod order.

 

c. Run F-Intermod and identify the frequency for each order and the associated power level.  The power level

shown will not be the same as the power you measured.

 

d. Click the menu Options and Nonlinear Coefficients and adjust the nonlinear coefficient for the intermod

order associated with the measured intermod frequency.  Run F-intermod again to recalculate the power

levels and check the new recalculated intermod frequency power.  Keep adjusting the nonlinear coefficient

until the recalculated power level for the frequency is the same as the measured level.  Once it is the same the

nonlinear coefficient is known for that intermod order and continue to do the same for the next intermod

order and frequency. 

This completes the nonlinear coefficient procedure.

Intermodulation Examples

 

The following examples use the default nonlinear coefficients that load with the program.

 

Example 1:

Five channels are inputted, 2 duplex, 2 half duplex and 1 simplex receive only. 

If the nonlinear coefficient is measured and is accurate then the worst offending intermod is 3rd order on channel 5, the

simplex channel. Power of -6.9 dBW  Channels 1 and 2 contribute to this intermod.

 

If the nonlinear coefficient is not calibrated, then we can say that there will be one 3rd order hit  on channel 5 with

unknown strength. 

For 5th order intermod the worst offenders (strongest intermod) will be on channels  1, 3 and 5. Intermod power levels are

unknown.

For 7th order intermod the worst offenders (strongest intermod) will be on channel 3. Intermod power levels are

unknown.
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To see the total interfering intermod power for each channel, uncheck "Show channel name in output", run again and then

click T.Pwr.

The Channel R/T column will be sorted and total power value for each channel will be shown.
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As can be seen above the worst intermod is on channel 157.5 MHz.

 Computer Platform Requirements and Specifications

General:

Required computer :Windows 98, NT, XP, ME, 2000, Vista

Minimum RAM memory : 128 Mbytes

Hard Drive Space : 10 MB

Resolution : 800x600 VGA Monitor or better

Other peripherals : one printer (not necessary)
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Input:

Transmit frequency : 0.00001 to 999,999.99999 for any units kHz, MHz, GHz, THz

Number of transmit freq. : 1 to 10000

Intermodulation order : 2 to 31

Receive frequency : 0.00001 to 999,999.99999 for any units kHz, MHz, GHz, THz

Number of receive freq. : 1 to 10000

Frequency bandwidth : 0.00000 to 999,999.99999 for any units kHz, MHz, GHz, THz

Output:

Intermodulation frequency range : 0.00000 to 999,999.99999 for any units kHz, MHz, GHz, THz

Maximum number of intermodulation output frequency listings : unlimited

Computing time : dependent on intermodulation order, number of transmit frequencies, receiver bandwidth, sorting time

and number of listings
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